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Audience:  High School Freshman 

  

Prior Knowledge:  Experienced in using computers and internet researching.  Limited 

knowledge in using Timeline software and Audacity software.  Pre-test will give us 

content area knowledge regarding of the Holocaust. 
  
Attitudes:  Students confident in using computers.  Eager to learn new uses for 

technology. 
  
Motivation:  Students are excited about using computers and learning new software.  

Students will also be able to choose ―person‖ in which to research.  Holocaust topic is 

an engaging topic for students. 
  
Education and Ability:  High School Freshman who are comfortable with technology.  

Maybe apprehensive with new software but will allow students to work in pairs to 

increase comfort level. 
  
Learning Preference:  Students desire hands on use of technology and like to 

collaborate with peers.  Class time will be given for using technology. 
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Subject:  History and Technology 
  

Grade: 9 

 

Topic: The Holocaust 

 

Content: The Holocaust, World War II, and Technology! 

 

Goals: The goals of this lesson are to learn about the Holocaust and how 

technology played a role in the atrocities but how it helped the 

liberator. Additional goals include learning how to use several types of 

technology including internet resources, software, and various pieces 

of hardware. The students will achieve these goals by creating a 

timeline of the Holocaust and its place on the timeline of the broader 

World War II; performing mock interviews with Holocaust survivors, 

guards, and bystanders; and, developing audio podcast interviews. 

Standards: Social Studies Standards:  

History, Grade 9, Benchmark E, 20th Century Conflict: 11. Analyze 

the consequences of World War II including: a. Atomic weapons; b. 

Civilian and military losses; c. The Holocaust and its impact; d. 

Refugees and poverty; e. The United Nations; f. The establishment of 

the state of Israel.  

 

Technology Standards: 

Technology and Society Interaction, Grade 9, Benchmark A, 

Technology and Citizenship, 4. Understand how different cultures 

develop their own technologies to satisfy their individual and shared 

needs, wants and values. 

  

Technology for Productivity Applications, Grade 9, Benchmark A, 

Understanding Operations, 1. Explore state-of-the-art devices to store 

data that will be used for researching projects. 

  

Objectives: Given introductory information, research resources, and sample 

timelines, students will be able work independently and/or within a 

team to create a timeline that includes important benchmarks of the 

Holocaust and where it fits within the broader timeline of World War 

II. Students will be able to gather enough knowledge of the Holocaust 

to engage in mock interviews, and create podcasts of these interviews. 

Materials: Computers with Internet access, Audacity software, microphones, 

smartboards, webcams, video cameras  
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Introduction: The students will begin by participating in a brief Introduction and 

overview of the Holocaust and information about the lesson. 

Development: Students will learn how to complete research on the Internet (including 

validating sources). They will learn to work cooperatively. They will 

learn about how technology impacts the world in big and small ways. 

And they will learn how to utilize several types of technology to learn 

and how to tell a story. 

Practice: Students will work in small groups to do research and they will work 

together to create the interviews and timeline. 

Accommodations: Accommodations will be made as required by individual student IEPs.  

In some cases the lessons will be modified if the technologies cannot 

be made accessible. 
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Lessons Week #1  

  

Pre-Test—  

Holocaust Pre-Test  

Name_____________________Date_________  

  

1. Did the Holocaust really happen?  

a. Yes b. No  

  

2. Who is responsible for the Holocaust?  

a. The German people b. Hitler c. Nazi‘s d. The world  

e. All of the above  

  

3. What is anti-Semitism?  

  

4. How many Jews lost their life during the Holocaust? Approximately:  

a. 500,000 b. million c. 2.5 million d. 6 million  

  

5. How many main concentration camps existed?  

a. 2-5 b. 5-10 c. 10-19 d. 20 or more  

  

6. Where were the camps located?  

a. Germany b. all over Europe  

  

7. What groups were targeted for ethnic cleansing?  

a. Jews b. Gypsies c. Mental or Physical Disabled d. Homosexuals  

e. Jehovah‘ Witnesses  f. Only a   g. All of the above plus others  

  

8.  What technologies were used in the camps either by the prisoners or guards?     

  

9.  Would the outcome have been different if other technologies had existed then?  

Please explain. 

  

The pre-test needs to be given prior to content to allow teacher to collect data.  

  

The pre-test is designed to determine prior knowledge so that as the lesson is 

implemented the teacher does not give information that they already know but builds on 

prior knowledge. This technique also allows the teacher to find any misconceptions that 

students bring to this class content. Sometimes teaching students with misconceptions 

is much harder to do than teaching students with no prior knowledge.  
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Reading of the picture book: Terrible Things  by Eve Bunting 

  

This book is an allegory, which can be used as a comparative organizer (an advanced 

organizer) which will help promote thoughtful consideration and/or debate.  It also 

allows for elaboration and perhaps even visual imagery. 

 

Reference: 

Goodrich, Frances and Albert Hackett. (1999).  An Allegory of the Holocaust.  

Retrieved  November 30, 2008 from Web site: 

http://www.sfusd.k12.ca.us/schwww/sch546/annefrankelit/IntoActivities,html/Activ.2.h

tml  

 

 

  

The entire story can be found at the above site and then the following questions from 

that site could be used to kick off a discussion rather than using it as a worksheet.  

  

TERRIBLE THINGS*  

1. Why do you think the author told the story of the Holocaust in this symbolic way? 

    Who is this story directed to?  

______________________________________________________________________ 

______________________________________________________________________  

2. Why do you think the Terrible Things take away the animal‘s one group at a time? 

    

______________________________________________________________________  

3.  In an allegory, people, places, and events are used as symbols. What can the 

     clearing in the woods stand for? What about the different animals? The Terrible 

Things? 

    

______________________________________________________________________ 

    

______________________________________________________________________  

4. What kind of excuses do the other animals offer to explain the fate of each group 

    as it is taken away? How do these reactions help the Terrible Things? 

    

______________________________________________________________________ 

5.  How are the Terrible Things described? What verbs are used to describe their 

actions?    How do the descriptions affect your feelings about the Terrible Things? 

http://www.sfusd.k12.ca.us/schwww/sch546/annefrankelit/IntoActivities,html/Activ.2.html
http://www.sfusd.k12.ca.us/schwww/sch546/annefrankelit/IntoActivities,html/Activ.2.html
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______________________________________________________________________ 

6.  During the Holocaust, terrible things were done by real people, people with faces, 

    names and life histories. Why do you think the author shows the Terrible Things 

    as anonymous? 

______________________________________________________________________ 

    

______________________________________________________________________ 

7. What choices do the animals in the clearing have when the Terrible Things come? 

    

______________________________________________________________________  

8.  What would you say to Big Rabbit's statement, "We are the White Rabbits.‖ It 

    couldn't happen to us? 

______________________________________________________________________ 

    

______________________________________________________________________  

9. When the Terrible Things come for the rabbits, what do the rabbits do? What 

    choice does Little Rabbit make? Why? What does this tell you about Terrible 

Things? 

    

______________________________________________________________________  

10.  Little Rabbit hopes someone will listen to him. Why might no one listen? 

    

______________________________________________________________________  

(Use the back of this paper if additional room is needed.  All answers must be in complete sentences,  
correct punctuation, and contain at least 2 or 3 sentences for each question.)  

* Taken from "A Study of Anne Frank" Scholastic Professional Books, p. 18.  

GRADE RUBRIC: 

10 points for each correct answer. A=90-100, B=80-89, C=70-79, D=60-69, F=0-59.  

Standing up for what you  

        know is right  

                    is not always easy.." Eve Bunting  
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Lesson Week Two:  Introduction, Research, and Mock 

Interviews 

  
In this lesson students will choose to be:  Victim, Perpetrator, Bystander, Resistor, 

Rescuer, Liberator, Survivor or Children.  Research will be gathered from that point of 

view and incorporated into the timeline and the interview. Using point-of-view format 

will allow the student to gain attention because it will most often evoke emotions and 

allow them to see personal significance. Having to put yourself into someone else‘s 

shoes may reveal the intrinsic value to students and help with meaningful learning. 

  

Introduction to Content and Timeline: Students will participate in a brief introduction 

and overview of the Holocaust including an abbreviated timeline, some real interviews, 

pictures, and videos (see Introduction Addendum).  The introduction will provide 

students with an expository organizer (advance organizer) in the form of an overview 

and outline of the information, as well as the timeline information.  The introduction 

will also serve as an opportunity to begin to form expectations about the topic.   

  

After the introduction and overview, students will be provided multiple resources to 

engage in ―guided research.‖  The guided research will be done by each student 

independently based upon the point of view they have been assigned and then there will 

be group activities to develop interview questions to be used for the next lesson.  

  

Students will also be asked to use Xtimeline (www.xtimeline.com) to create a timeline 

of the Holocaust and the broader World War II.  One the timeline, students will be 

asked to place technologies that they felt had an impact on the Holocaust either in terms 

of or from the perspective of Hitler, the Nazi‘s, victims, bystanders, liberators, and 

etcetera.  As part of their timeline, students will be asked to provide a one-page 

discussion of how modern technologies would have impacted the Holocaust and 

whether they believe that modern technology would have changed the outcome of the 

Holocaust.  This part of the lesson allows students time for spaced practice and 

repetition as well as participating in meaningful learning as they try to relate modern 

technology to a historical event.  It also allows students to participate in elaboration as 

they try to synthesize the information into a meaningful timeline and answer higher-

level questions about how technology played a part at the time, and would have 

impacted the events if modern technologies would have been available. 

  

Providing the pre-test, the introduction, and then the research also provides students 

with spaced repetition and practice so that the information is better organized and easier 

to retain.  Having multiple ways to interact with the information allows for deeper 

levels of processing and leads to meaningful learning and elaboration.  

  

http://www.xtimeline.com/
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Introduction to Research Goals and Methods: This lesson will 

build on prior research skills. Students will take notes from internet sources that will 

help them create a timeline and an interview.  There will be higher level thinking skills 

going on since their notes will only need to be from their ―person‘s‖ point of view, 

which also makes this information more meaningful.  

  

Students may use sites that have been collected and linked to a teacher site. Some sites 

are listed below. The student may choose to search the internet for additional sites in 

which case the teacher needs to review with students—the need to evaluate credibility 

and validity of internet sources. Sources should be documented in MLA format—quick 

review on how to document online sources.  

  

Allow students to start project in school to guide their initial research as necessary.  

  

  

  

Introduction To Interviewing 

Students will be given a brief introduction to interviewing skills and the technologies 

that will be used during the interviews.  Students will be provided information and 

practice in developing the different types of questions including open-ended, closed, 

and critical thinking questions.  These exercises will provide students with expository 

and comparative organizers (advance organizers) by giving them opportunities to see 

different examples of each, and to practice developing a few sample questions in each 

category, which also provides opportunities for practice and repetition. 

Interviewing is a vital skill for anyone trying to get more information. It is one of the 

most important ways to gather information and create content for a story. Good 

interview techniques require practice so don‘t expect to master it immediately.   

There are more ways to gather information than from your text or your teacher. 

Experts, grandparents, historians, scientists, authors, and many others all have 

interesting and important stories to tell. To get the most out of interviewing these 

people, you need to consider a few things that will help you get the most out of your 

interview.    

Techniques used  

    

1. Preparing for the Interview   

2. Conducting the Interview   

3. Ask an Expert advice   

4. Interview Questions   

5. Open-Ended Questions   

6. Leading Questions  
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Preparing for the Interview  

1.      Make an appointment with the person (it is rude to just show up and 

expect the person to give you their time).  

2.      Learn a little about the person before meeting him/her.  

3.      Know what you want to get out of the interview ahead of time.  

4.      Write your questions down before the interview, but be prepared to take a 

different path of questioning if necessary.  

Conducting the Interview  

1.      Be on time, and be prepared with paper and pen/pencil.  

2.      Be friendly and courteous - remember they are giving you their valuable 

time!  

3.      Ask your questions clearly.  

4.      Don't interrupt!  

5.      Ask specific, thought-provoking questions. Avoid yes/no questions.  

6.      Try to stay focused, but if something interesting comes up go with it.  

7.      Take good notes. Ask the interviewee to repeat what they said if 

necessary, but only do this when it is something important.  

8.      Don't volunteer information unless it is to get the interview going, to get it 

back on track, or to give background information relevant to your goals.  

9.      Obtain all the information needed before ending the interview. If 

necessary, review your notes with the person.  

10.  Thank the interviewee for his/her time.  

Ask an Expert advice  

Many experts are offering their time to students. If you have this opportunity either in a 

chat room or e-mail, you should follow the above advice, with the exception of getting 

straight to the point. Don't waste time "getting to know" the expert. Ask your questions 

and move on.  
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Interview Questions   

Most interviews seek to achieve one or more of the following goals:   

1.  Obtain the interviewee's knowledge about the topic    

2.  Obtain the interviewee's opinion and/or feelings about the topic    

3.  Feature the interviewee as the subject    

It's important that you know exactly why you are conducting an interview and which 

goal(s) you are aiming for. Stay focused on questions and techniques which will 

achieve them.   

Do your homework. You will be expected to have a basic knowledge of your subject. 

Do not roll up to an interview with a band and ask them how many albums they have 

released — you should know this already. If you show your ignorance, you lose 

credibility and risk being ridiculed. At the very least, the subject is less likely to open 

up to you.   

Have a list of questions. It seems obvious but some people don't think of it. While you 

should be prepared to improvise and adapt, it makes sense to have a firm list of 

questions which need to be asked.   

Of course many interviewees will ask for a list of questions before hand, or you might 

decide to provide one to help them prepare. Whether or not this is a good idea depends 

on the situation. For example, if you will be asking technical questions which might 

need a researched answer, then it helps to give the subject some warning. On the other 

hand, if you are looking for spontaneous answers then it's best to wait until the 

interview.   

Try to avoid being pinned down to a preset list of questions as this could inhibit the 

interview. However, if you do agree to such a list before the interview, stick to it.   

Ask the subject if there are any particular questions they would like you to ask.    

Back-cut questions may be shot at the end of a video interview. Make sure you ask the 

back-cut questions with the same wording as the interview — even varying the wording 

slightly can sometimes make the edit unworkable. You might want to make notes of 

any unscripted questions as the interview progresses, so you remember to include them 

in the back-cuts.   

Listen. A common mistake is to be thinking about the next question while the subject is 

answering the previous one, to the point that the interviewer misses some important 

information. This can lead to all sorts of embarrassing outcomes.    
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Open-Ended Questions   

The ability to ask open-ended questions is very important in many vocations, including 

education, counseling, mediation, sales, investigative work and journalism.    

An open-ended question is designed to encourage a full, meaningful answer using the 

subject's own knowledge and/or feelings. It is the opposite of a closed-ended question, 

which encourages a short or single-word answer. Open-ended questions also tend to be 

more objective and less leading than closed-ended questions (see next page).   

Open-ended questions typically begin with words such as "Why" and "How", or 

phrases such as "Tell me about...‖ Often they are not technically a question, but a 

statement which implicitly asks for a response.   

Examples   

   

Closed-Ended Question       Open-Ended Question   

Do you get on well with your 

boss?    
    Tell me about your relationship with your boss.    

Who will you vote for this 

election?    
    

What do you think about the two candidates in this 

election?    

What color shirt are you 

wearing?    
    That's an interesting colored shirt you're wearing.    

How do you feel?   

Perhaps the most famous (or infamous) open-ended question is "How does this make 

you feel?" or some variation thereof. This has become a cliché in both journalism and 

therapy. The reason it is so widely used is that it's so effective.   

In journalism, stories are all about people and how they are affected by events. 

Audiences want to experience the emotion. Even though modern audiences tend to 

cringe at this question, it's so useful that it continues to be a standard tool.   

In psychology, feelings and emotions are central to human behavior. Therapists are 

naturally keen to ask questions about feelings.   

  
    

Leading Questions   
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A leading question is a question which subtly prompts the respondent to answer in a 

particular way. Leading questions are generally undesirable as they result in false or 

slanted information. For example:    

   

Do you get on 

well with your 

boss?    

    

This question prompts the person to question their employment 

relationship. In a very subtle way it raises the prospect that maybe 

they don't get on with their boss.   

Tell me about 

your relationship 

with your boss.   

    

This question does not seek any judgment and there is less 

implication that there might be something wrong with the 

relationship.   

The difference in the above example is minor but in some situations it can be more 

important. For example, in a court case:   

   

How fast was the red 

car going when it 

smashed into the blue 

car?    

    

This question implies that the red car was at fault, and the 

word "smashed" implies a high speed.    

How fast was each 

car going when the 

accident happened?    

    

This question does not assign any blame or pre-judgment.   

    

    

More Interview Tips   

These are very general tips which apply differently to different situations. Use your 

judgment to decide when and how to use them.    

Dress appropriately, or at least dress with a purpose. Your appearance will influence the 

way interviewees respond to you.   

Try to be unique, so it's not just another interview rehashing the same questions the 

subject has answered many times before. Don't push this too far though — if you try to 

be cute or disarming it may backfire.    

Be honest. Sometimes it's tempting to lie or omit important information when securing 

an interview. This isn't just unethical; it will damage your career in the long run.   

Don't have an attitude if you want a quality interview. A confrontational approach is 

less likely to get good information.   



14 

 

Stay neutral. Try not to ooze bias. Don't appear to be persuaded by the subject's 

opinions. Don't judge or directly criticize the subject.    

Don't interrupt. This can upset the subject's train of thought.   

Minimize your own vocals (in video and audio interviews). Ask questions clearly and 

succinctly, and then let the person speak without any more words from you. Learn to 

react silently as the subject talks — rather than saying things like "uh-huh, right, I see", 

use nods and facial expressions.   

Don't over-direct. Try not to give the subject too many instructions or be too specific 

about what you want them to say. In most cases it's better to let them speak freely.   

Show empathy. Often you will need to cover sensitive or distressing topics. Show some 

compassion for the subject without getting too emotional. Ask for permission before 

asking difficult questions, e.g. "Is it okay to talk about...?"   

It's not about you. Don't talk about yourself or add your own opinion. Your questions 

can be long enough to add information or interest about the topic, but the interviewee is 

who the audience wants to hear from.    

Take an interest in psychology. Interviewing is very closely associated with 

psychology. The better you understand how people think, the better you will be able to 

extract their thoughts from an interview.   

When you finish the interview put your notebook or recorder away and have an 

informal chat. As well as being polite and leaving a good impression, you might be 

surprised at what additional information flows when the subject thinks it's all over and 

is more relaxed.    

If you missed a question from the interview, you might be able to call the subject back 

later and get the answer. You get one shot at this — call them back twice and you'll 

probably be out of luck. Obviously the call-back will be more difficult for video 

interviews, but you might still be able to voiceover the answer yourself during the 

story.   

  

  

  

  

  

Basic Audio Podcasting  
For the last part of this lesson, students will create audio podcast interviews in their 

groups. This portion of the lesson will actively involve the students in the learning 

process of practicing interviewing skills and techniques, recording, editing and 

producing a final product. Throughout this process, students will be active participants 
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and will control their own learning from researching information near the beginning to 

creating an audio recording about the topic at the end. 

   

Supplemental Video Tutorials to get started:  
http://audacity.sourceforge.net/manual-1.2/tutorials.html  
http://www.youtube.com/watch?v=IC3VZkfdgV8  
   

1. Hardware Computer: Desktop or Laptop  

 

You can use any computer to record and publish your podcast. You can choose either a 

PC or Mac depending on preference or availability. The basic process for either (PC or 

Mac) remains the same; the software programs used might differ in some cases.  

Recording Device  
 

You don‘t need an iPod to create podcast or listen to a podcast.  

To record your audio using your computer, you can just plug your headset (with 

microphone) in and get started. It‘s a good idea to buy a headset with noise-canceling to 

filter out unwanted background noise to improve the quality of your recording. Also 

you can use digital voice recorders for mobile recording. There are many brands 

available at different price levels. You can use microphones to record audio as well.  

   

2. Software:  

 

Audacity   
Audacity is free, open source software to use to create your audio and export your 

recording to an MP3 audio file for use in the podcast. Be sure to download and extract 

the LAME MP3 encoder. It is required for exporting audio to MP3 using Audacity.  

Free Download Audacity (for PC and MAC): http://audacity.sourceforge.net/  

Free Download LAME mp3 encoder: 

http://audacity.sourceforge.net/help/faq?s=install&item=lame-mp3   
   

iTunes  
iTunes is a digital media player application, introduced by Apple for playing and 

organizing digital music and video files. Users can subscribe to and manage podcasts 

using iTunes. Free download (for Mac and Windows): 

https://www.apple.com/itunes/download/  
   

How to Begin Recording  
 

1. Connect the Audio Source  
To record audio from an external source you have to connect your audio recording 

device.  

http://audacity.sourceforge.net/manual-1.2/tutorials.html
http://www.youtube.com/watch?v=IC3VZkfdgV8
http://audacity.sourceforge.net/
http://audacity.sourceforge.net/help/faq?s=install&item=lame-mp3
https://www.apple.com/itunes/download/
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If you are using a microphone, plug the microphone in to your computer. Depending on 

the microphone and how close you sit next to your audio speakers, you might want to 

route your audio output to your headphones instead.  

If you are using a digital voice recorder to record audio: Record your audio and then 

plug the recorder in to your computer. Open the audio file in the recorder using 

Audacity. Note: Some voice recorders may not create files directly in to an mp3 format. 

Before using (or buying) a voice recorder, you may want to check what format(s) it 

creates files in. Accordingly you might have to use a converter to convert the audio file 

in to mp3. For Podcasting you will need an mp3 file.  

You can also use pre-recorded audio files or podsafe music files available on internet 

to.  

   

2. Set the Input Level  

 

Windows Volume Control  
When you are ready to record, plug your microphone into your soundcard's mike input. 

Make sure you have the correct settings to record your voice.  

Open up volume controls Windows's Volume Control by clicking on the Volume tray 

icon or through Start > Control panel > Sound and audio devices > Audio tab > Click 

one of the volume buttons.  

   

Click Option >Properties and then select Recording  

Make sure Microphone is selected as the source and click Ok  

Adjust its volume to as high as you would like  

Set up Audacity  
Make sure you have downloaded and installed Audacity. Once installed you should be 

able to see the Audacity icon on your desktop. Double click on the Audacity icon to 

open it.  

   

2. Setting Preferences in Audacity  

Start Audacity and with a New Project open (gray desktop)  

Click Edit tab and locate the Preferences menu  

Under the Audio 1/O tab  

Under Device select your soundcard from the drop down menu (by default 

Microsoft is selected)  

Under Channels select Recording Channels to be ‗1 (Mono)‘  

Uncheck "Play other tracks while recording"  

3. Record- Edit- Save using Audacity  
Make sure you have downloaded and installed Audacity and LAME encoder. Open 

Audacity – Click on icon on desktop  

   

I. Record Audio  



17 

 

Open Audacity and set up your computer for recording. Plug a microphone 

into the microphone jack of your computer (Usually right next to the headphone 

jack. It may on the front as shown or on the back.)  

Click the Record button to start recording your audio  

Check the Meter Toolbar while recording - The Meter Toolbar is a visual way 

of checking that audio is going in to or out of Audacity when you record or play. 

The Meter Toolbar is located alongside the Play controls. A red volume level 

bar should be visible when you speak in to the microphone.  

Once you are finished recording your audio, click the Stop button to stop 

recording.  

You may hit Pause button anytime to pause recording.  

You can click Play button to listen to the audio  

   

Step II: Edit your Audio track  
To make your recording as smooth and free of noise and disturbance it‘s a good idea to 

spend some time editing it to get good quality audio and listening experience for users. 

Try to work in a quiet environment to get best results.  

To cut-copy or delete unwanted sections from the track, make sure Selection 

tool is highlighted in the toolbar.  

On the track, press and hold the left mouse button while you drag the mouse to 

highlight the section of the audio you want to cut , copy and then press : Ctrl + 

C to Copy Ctrl + X to Cut Ctrl + V to Paste or Delete to delete (To undo this 

operation, select Undo in the Edit menu or press Ctrl + Z)   

   

Time Shift Tool  
This tool allows you to change the relative positioning of tracks relative to one another 

in time. To use this tool, click on the Time Shift Tool. Now simply click in a track and 

drag it to the left or right.  

   

Envelop Tool  
The envelope tool gives you detailed control over how tracks fade in and out, right in 

the main track window.  

When the envelope tool is selected, the amplitude envelope of each track is 

highlighted, with control points at the beginning and end of each track.  

To change a control point, click it and drag it to a new position.  

To add a new point, click anywhere in the track where there is not already a 

control point.  

To remove a point, click on it and drag it outside of the track until it 

disappears, then release.  

   

Silence Tool  
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Erases the audio data currently selected, replacing it with silence instead of removing it 

completely.  

Make sure the Selection tool is highlighted and select the part of the track that 

you want to add silence to.  

Click the Silence tool.  

   

Step III: Save your audio (Export file as mp3)  

From the File menu, choose Export to MP3 from the File menu.  

Note : Make sure you have Lame encoder (required with Audacity to export 

audio files in mp3 format)  

Enter audio details (ID3 tags).Click Ok.  

Note: ID3 tag is a metadata container used for mp3 files. It allows information 

such as the title, artist, album, track number, or other information about the file 

to be stored in the file itself.  

The audio will be saved on your computer in mp3 format  

   

You have now successfully created an audio podcast. 
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Guided Research Links 
  
http://www.brainpop.com/search/index.weml?keyword=holocaust  
  
http://www.xtimeline.com/search.aspx?q=holocaust  
  
http://www.holocaust-history.org/short-essays/  
  
http://www.ushmm.org/education/forstudents/  
  
http://college.usc.edu/vhi/about/survivingauschwitz/index.php  
  
http://www1.yadvashem.org/education/index_education.html  
  
www.holocaustchronicle.org  
  
http://www.bv229.k12.ks.us/HMS_LMC/Webquest%20for%20Holocaust/Teach
er%20WebQuest%20Page.htm 
  
http://www.lamoth.org/educational.html 
  
http://news.cnet.com/1606-2_3-50004133.html 
  
http://history1900s.about.com/cs/survivors/ 
  
www.holocaustsurvivors.org 
  
http://holocaust.umd.umich.edu/ 
  
http://www.pbs.org/wgbh/amex/holocaust/timeline/index.html 
  
http://remember.org 
  
Video clips: 
  
http://www.encyclomedia.com/video-discovery_of_the_holocaust.html 
  

http://www.brainpop.com/search/index.weml?keyword=holocaust
http://www.xtimeline.com/search.aspx?q=holocaust
http://www.holocaust-history.org/short-essays/
http://www.ushmm.org/education/forstudents/
http://college.usc.edu/vhi/about/survivingauschwitz/index.php
http://www1.yadvashem.org/education/index_education.html
http://www.holocaustchronicle.org/
http://www.bv229.k12.ks.us/HMS_LMC/Webquest%20for%20Holocaust/Teacher%20WebQuest%20Page.htm
http://www.bv229.k12.ks.us/HMS_LMC/Webquest%20for%20Holocaust/Teacher%20WebQuest%20Page.htm
http://www.lamoth.org/educational.html
http://news.cnet.com/1606-2_3-50004133.html
http://history1900s.about.com/cs/survivors/
http://www.holocaustsurvivors.org/
http://holocaust.umd.umich.edu/
http://www.pbs.org/wgbh/amex/holocaust/timeline/index.html
http://remember.org/
http://www.encyclomedia.com/video-discovery_of_the_holocaust.html
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http://college.usc.edu/vhi/about/onehumanspirit/?gclid=CJKIm-GD-
pYCFQazsgodJhITYg 
  
C-net video: 
  
http://news.cnet.com/1606-2_3-50004133.html 
  
 

  

Lesson analysis: 

 

 prior knowledge – Data regarding the prior knowledge that the students have in 

relation to the Holocaust will be obtained through the pre-test given at the 

beginning of this unit.  

    Prior knowledge of the subject matter allows for students to link new concepts to 

their existing knowledge; this provides the opportunity for meaningful learning. 

Prior knowledge also enables individuals to encode information into their long-term 

memory. 

 misconceptions – Students‘ misconceptions related to the Holocaust should be 

identified through the pre-test, allowing for the teacher to address the 

misconceptions before proceeding with the unit.  

     Misconceptions are inaccurate beliefs or knowledge. If the students‘ 

misconceptions are not identified and a conceptual change does not occur before the 

lessons begin, then they may disregard accurate information that does not coincide 

with their current misconceptions and will not learn the subject matter effectively.   

 advance organizer – Advance organizers are used in several places throughout this 

unit. The book Terrible Things provides an advance organizer of the information 

about the Holocaust. The teacher-directed introduction to the content and timeline 

in week two of this unit also provides the students with an advance organizer. The 

exercises that the students will complete during the introduction to interviewing 

skills will provide students with expository and comparative organizers (advance 

organizers) by giving them opportunities to see different examples of interviewing 

techniques, and to practice developing a few sample questions in each category.  

     Advance organizers can provide the opportunity for students to learn more  

effectively by giving them a rough outline of the information that will be given to 

them during the unit; allowing for both internal and external organization.  

 elaboration – Elaboration is allowed for both during the reading of Terrible Things 

and during the creation of the timeline. Both activities provide the opportunity for 

the students to think about the material presented to them and interpret it in their 

own way.  

     Elaboration is the process of receiving information and interpreting more about 

the subject than was actually presented. Elaboration is an effective way to connect 

and organize new information. 

 visual imagery – The students will have the opportunity to create their own visual 

imagery related to the content during the read aloud of the book Terrible Things.  

http://college.usc.edu/vhi/about/onehumanspirit/?gclid=CJKIm-GD-pYCFQazsgodJhITYg
http://college.usc.edu/vhi/about/onehumanspirit/?gclid=CJKIm-GD-pYCFQazsgodJhITYg
http://news.cnet.com/1606-2_3-50004133.html
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     Visual imagery involves the mental pictures that people have stored in their 

memory. According to our text, ―research consistently indicates that forming visual 

images can be a powerful means of storing information in long-term 

memory‖(p.207).  

 meaningful learning – There is an opportunity for meaningful learning several times 

throughout this unit. The mock interview process requires the students to put 

themselves into the shoes of an individual that lived during the Holocaust, which 

could promote the student to link similarities between the person that they are 

portraying and themselves, allowing for meaningful learning. Using modern 

technology (existing knowledge) and relating it to the events that occurred during 

the Holocaust to create a timeline can also provide the opportunity for meaningful 

learning. 

     Meaningful learning occurs when we link new information with existing 

knowledge to store it in our long-term memory. Linking the new information to 

existing knowledge allows for quicker storage and easier retrieval of the 

information at a later time.  

 expectations – The students will be able to form expectations about the information 

that they will be learning during this unit during the teacher led introduction at the 

beginning of the unit. 

When expectations about the topic to be learned are formed, they activate the 

coinciding portions of the long-term memory and allow for easier and/or quicker 

storage of new information. 

 spaced practice and repetition - Providing the pre-test, the introduction, and then the 

research also provides students with spaced repetition and practice so that the 

information is better organized and easier to retain. 

     According to our text, ―reviewing and practicing information and procedures at 

periodic intervals over the course of a few weeks, months, or years clearly enhances 

retention and performance‖ (p.219). 

 levels of processing – The students will have multiple ways to interact with the 

information, which allows for deeper levels of processing. The students will have 

the opportunity during the unit to think about the subject matter on all five of the 

levels in the levels-of-processing model. 

     According to the levels-of-processing model, it is only when we interpret, 

understand, and relate new information to previous learning that we place it in our 

long-term memory. When an individual is required to think about a topic at higher 

levels such as answering ―what‖ and ―why‖ questions rather than memorization, the 

information is linked to prior knowledge, is more meaningful, it is stored in the 

memory more quickly and is easier to retrieve. 

 higher-level thinking skills - There will be higher level thinking skills going on 

during the mock interviewing process since the students‘ notes will need to be from 

their ―person‘s‖ point of view, which also makes this information more meaningful. 

     Higher-level thinking skills require the individual to analyze, synthesize, or 

evaluate material rather than memorization. They are required to do something with 

knowledge, not just be able to repeat it. When an individual is required to think 

about a topic at higher levels such as answering ―what‖ and ―why‖ questions rather 
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than memorization, the information is linked to prior knowledge, is more 

meaningful, it is stored in the memory more quickly and is easier to retrieve. 

 schemas and scripts – Students will undoubtedly relate the information presented 

during this unit to their own schemas and scripts that are already in place from 

seeing pictures, videos, etc. related to the Holocaust previously.  

      Schemas and scripts relate to specific objects and events. Our text states, ―Other 

research provides further support for the idea that schemas and scripts influence 

how learners process, store, and remember new information‖ (p.263). 

 enactment – The students will be learning interviewing skills during this unit and 

will then be able to use these interviewing skills during their mock interview which 

provides the opportunity for enactment. The physical act of performing the mock 

interview and using the interviewing skills that were learned during the unit will 

promote the interviewing skills to long-term memory better than learning the skills 

and not having the chance to enact them.   

     Enactment is the act of doing something that is being learned. Behaviorists 

promote active responding in the learning process and social cognitive theory notes 

the importance of motor reproduction during modeling. Our text states ―A wide 

variety of physical actions seem to promote long-term memory storage‖(p.218).  

      

   


